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New in this release
The following sections detail what’s new in IP Softphone 3456 User Guide (NN43080-
100) for Nortel Communication Server 1000 Release 6.0:

• Features (page 5)

• Other changes (page 5)

Features
The IP Softphone 3456 User Guide (NN43080-100) is new for CS 1000 Release 6.0.

Other changes
Revision history

June 2009 Standard 01.02. This documents reflects a change to Nortel 
preferred configuration list.

June 2009 Standard 01.01. This document is a new NTP for Communication 
Server 1000 Release 6.0.
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Welcome
This section introduces IP Softphone 3456 and describes the available 
features.

Navigation
• Your new IP Softphone 3456 (page 6)

• Requirements (page 7)

• Online help (page 7)

• Nortel preferred configurations (page 7)

• Related publications (page 7)

Your new IP Softphone 3456
The current IP Softphone 3456 offering provides instant messaging, and voice 
and video communications. The Communication Server 1000 and IP 
Softphone 3456 provide voice, video communication with rich telephony 
features.
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Requirements
The following basic hardware specification is required to operate the 
IP Softphone 3456:

• Intel Pentium III 1.3 GHz or equivalent

• Windows 2000/XP/Vista

• 512 MB RAM

• 50 MB hard disk space

• 16 Bit, full-duplex sound card

• IP connection

Depending on the configuration of your workstation or laptop, you may also 
need to obtain a microphone and speakers, or a USB headset with 
microphone. If it is your intention to use the softphone video call/conferencing 
features, you will also need a webcam.

Online help
For detailed information about specific client features, see the help 
documentation provided with IP Softphone 3456. To access help, in the 
IP Softphone 3456, click Actions and then click Help.

Nortel preferred configurations
The following list contains preferred configurations for the Nortel IP Softphone 
3456

• Disable the provisioning server on the phone. On the phone, navigate to 
Preferences > Advanced > No login server available.

• Configure only the G711 and G729 voice codecs for the IP Softphone 
3456.

• On client, Nortel recommends a fixed port range defined under Account 
Settings > Topology > Port Range to set the port.

• Ensure the registration refresh time is set to five minutes. This keeps the 
registration timer short enough to recover quickly in case of network 
failure.

• To make the IP Softphone 3456 DTMF work with the Media Application 
Server (MAS), ensure that SIP > Account > Topology > Enable ICE is not 
selected.

Related publications
For more information, see the following related publications:

• Communication Server 1000E suite of documentation
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Feature overview
This section describes features that are available on the IP Softphone 3456.

Navigation
• Starting up (page 8)

• Signing in (page 9)

• Making a call (page 10)

• Receiving calls (page 12)

• Placing calls on hold (page 13)

• Mute (page 15)

• Call Transfers (page 15)

• Conference Calls (page 28)

• Voicemail (page 32)

• Video Phone (page 34)

Starting up
Start the IP Softphone 3456 by double-clicking the desktop icon, or by clicking 
the Start menu and navigating to the IP Softphone 3456 program group and 
clicking IP Softphone 3456.
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Signing in
The IP Softphone 3456 should sign in to your SIP account automatically if your 
account has been correctly configured. In some circumstances (depending on 
how the system administrator has configured the softphone), you may be 
asked to authenticate to a login server during application start up. If you are 
unsure how to login, see your system administrator.

Screen layout
Before continuing, it would be worth spending some time on the interface 
layout. Not all function buttons are visible when the phone is inactive - for 
example, call transfer and hold options do not appear unless the phone is 
engaged on a call. Other function buttons, such as the voicemail notification 
button, only appear as follows: 

• when configured to do so (see the system administrator).

• when you receive a message.
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Making a call
Calls can be made from the IP Softphone 3456 in a number of different ways. 
Users can make calls by double-clicking on any name in the contact list, by 
typing a number in using the keyboard and pressing Enter, or by opening the 
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dial pad and using the mouse to click on the numbers required. The following 
instructions show you how to open the dial pad and dial a number using the 
mouse.

1 Click the dial pad button .

2 Using the mouse, click on the dial pad numbers that you would like to dial. 
The number appears on the display screen.

3 Click the dial button  . End the call by clicking on . 
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Receiving calls
When a call is received by the IP Softphone 3456, a number of things occur. 
First, the phone rings (if sound is enabled on your system); second, the 
caller’s number or ID is displayed on the IP Softphone 3456 display screen.

Thirdly, if the IP Softphone 3456 is running in the background, that is, if you 
are working in another application, a Web browser, for example, you still see 
a visual notification of the call, in the form of a pop-up messages that appears 
just above the clock on the Windows task bar.
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To answer the call:

• Click on the found on the IP Softphone 3456 interface.

or

• Click on the found on the desktop pop-up.

To reject the call and forward it to your voicemail service (if configured), click 
on .

Placing calls on hold
Calls can be placed on hold at any time. When a call is on hold, you cannot 
hear the caller and they cannot hear you. When a call is on hold, the message 
‘Call on hold’ is displayed on the screen and the hold button  is 
highlighted.
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When a call is on hold, it is possible to make a second call by pressing the 
Start another call button .

Hold and resume
To place a call on hold, press the Hold button during the call. To resume the 
call, just press the Hold button again.

Hold and open another call
1 During a call, press the Start another Call button . A new dial tab 

opens in the interface window. 

2 Dial the new recipient’s number.

3 Click the  button.

4 To switch between calls, click on the tabs. Whenever you select a tab, all 
other calls are placed on hold.

5 To end a call with either party, click the  button.
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Call waiting
When you are on a call and another call comes in, the phone rings and the 
second call appears in a tab on the phone screen. To answer the call and 
place the current call on hold, click the new caller tab. The new call is 
answered when you click the tab, so there is no need to click the green answer 
button.

Mute
At any time during a call, you can mute your microphone so that the caller 
cannot hear what you are saying; you, however, are still be able to hear them. 
To mute a call, click on the Mute button (the Mute button is only displayed 
during calls).

Call Transfers
The IP Softphone 3456 offers users a number of different ways to transfer 
calls:

• Blind transfer – Pass a call directly to another extension without waiting 
for an acknowledgment or busy signal from the destination.

• Announced transfer – Ring the destination extension first and announce 
the call before transferring it through.
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• Quick transfer – Pass the call straight to a number in your quick transfer 
list (more on this later in this section), or to your chosen Default quick 
transfer destination.

Each of these transfer methods are described in the following sections:

• Blind Transfer (page 16)

• Announced Transfer (page 18)

• Quick Transfer List (page 20)

Blind Transfer
A blind transfer is probably the easiest method of transfer available on the 
IP Softphone 3456 interface and is performed in the following way.

1 Answer the call by clicking the  button.

2 During the call, press the drop-down menu button located just to the right 
of the Default Transfer button (the transfer button only appears on 
phone display when an active call is in progress).

3 Select Transfer this call.
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4 When prompted, enter the destination number using either the dial pad or 
the numeric keys on your keyboard.

5 Click the Transfer button.

6 The call is passed to the transfer destination and your phone hangs up.
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Announced Transfer
An announced transfer is often seen as the preferred method of call transfer, 
because it enables you to find out whether the destination recipient is available 
and ready for the transfer or not.

To perform an announced transfer:

1 Answer the call by pressing the  button.

2 During the call, press the drop-down menu button located just to the right 
of the Default Transfer button (the transfer button only appears on 
phone display when an active call is in progress).

3 Click on Call then Transfer.
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4 A new tab opens and the caller is placed on hold. Enter the transfer 
destination’s number.

5 Click the  button.

6 When the recipient answers, announce the caller and then press the 
Transfer button.

Note: If the recipient does not answer, you can return to the call originator 
by clicking the  button to disconnect the second call (ensure that the 
second call tab is selected, otherwise you will disconnect the caller).
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7 The call is transferred to the destination and your phone hangs up.

Quick Transfer List
A quick transfer list can be created to provide users with fast access to 
common transfer destinations – for example, a Personnel Assistant (PA) may 
require fast access to a select group of managers that they commonly field 
calls for. Once created, a quick transfer list can be accessed during an active 
call and the caller can be transferred quickly to any of the numbers.

Note: When you transfer a call using the quick transfer list, you are in effect 
performing a blind. In other words, you will not be able to announce the call; 
the caller is simply passed directly to the destination whether the recipient is 
available or not.

Any number in the quick transfers list can be selected as the Default transfer 
number. Calls can be quickly transferred to the Default number by simply 
clicking the Default Transfer button .

Creating a Quick Transfer List
A quick transfer list can be made up of as many contacts as you wish; 
however, the longer the list, the longer it takes you to find the right contact 
during a call, thereby defeating the object of the quick transfe’ list.
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To create a quick transfer list:

1 From the main interface screen, open the File menu and select 
Preferences.

2 Click on the Quick Transfer button.
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3 Click the Add button.
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4 Enter the full name and phone number of the quick transfer contact.

Note: To set this contact as the Default quick transfer contact (the number 
that calls are forwarded to if you click on the Default Transfer button  
), select the check box. The default contact will appear with a checkmark 
next to it in the list of quick transfer numbers.

5 Click OK.

6 The new contact is displayed in the quick transfers list. Click OK to finish.

Quick Transfer List Transfers
To perform a transfer using a number from your quick transfers list:

1 Answer the call by pressing .

2 During the call, press the drop-down menu button located just to the right 
of the Default Transfer button (the default transfer button only 
appears on phone display when an active call is in progress).

Note: To send the call directly to your default quick transfer contact, just 
press the Default Transfer button.
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3 Select the name of the person to whom you would like to transfer the call.

4 The call is transferred and the phone hangs up.

Contacts
The lower half of the IP Softphone 3456 interface is dedicated to Contacts 
and call history (History). The following sections deal briefly with the 
principles of adding, viewing, and calling contacts.

Creating Contacts
Contact information can be imported from a variety of sources, including CSV 
files and Outlook Exchange servers; however, this guide deals exclusively 
with creating new contact profiles. For instructions on importing contact 
information, see the built-in help file that is accessed by clicking on the Help 
menu.

To create a new contact profile:

1 From the main phone screen, open the Contacts menu and select Add a 
Contact. If the Address Book panel is open (the lower half of the 
IP Softphone 3456 interface), click the Add a Contact button .
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2 Enter the name details of the contact and select a Group (for example, 
Work, Friends, etc).

3 In the lower half of the screen, select a contact type (for example., Home, 
Office, Softphone, etc) from the contact Method drop-down menus, and 
enter the contact’s phone number(s) in the corresponding Number/
Address field(s).
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4 If you entered more than one contact number, open the top-right drop-
down menu and select the preferred default contact method that will be 
used when you double-click on the contact’s name in the address book.

Note: If you enter a softphone number, you have the option of viewing the 
contact’s availability. Select the Show this contact’s availability check 
box to enable this feature.

5 Click OK.

Viewing Contacts
Contacts are arranged into Groups in the Address Book panel. Each 
contact’s group allocation is determined when the contact profile is created, 
see the previous section, Creating Contacts (page 24). To view a contact’s 
profile, simply click on their name in the Address Book panel.
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Dialling Contacts
To dial a contact straight from your Address Book, either double-click on the 
contact’s name or, in cases where more than one number exists for the 
contact, single-click and then select the required location number from the 
profile bubble.

Contacts can also be called by right-clicking on the contact in the Address 
Book and selecting Call Contact.

Contact information stored in Microsoft Outlook 2003 can also be utilized by 
the IP Softphone 3456. Open a contact in Outlook and click the Nortel badge 
found on the tool bar (if you cannot see the Nortel badge, open the View menu 
and select Toolbars, and check that eyeCall is selected). A list of numbers 
stored for that contact are displayed in a drop-down menu. Click the number 
that you would like to dial.

Note: The IP Softphone 3456 starts automatically if it is not currently running 
in the background.



- 28 -
Feature overview

Nortel Communication Server 1000
IP Softphone 3456 User Guide

NN43080-100   01.02 
6.0 12 June 2009

Copyright © 2009 Nortel Networks

Conference Calls
There are two ways in which a conference call can be established on the 
IP Softphone 3456:

• Start a conference while on a call by clicking the Conference button . 
Add participants either by entering their number and clicking the 
button  or by right-clicking on a contact in the Address Book and 
selecting Add to Conference.
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• Start or receive a call, open other calls using the Start Another Call 
button  and then, once connected, click on the Conference All button. 
All active calls will be joined to one conference.
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Managing Conference Calls
Removing Participants
A participant can be removed from the conference call and placed into a 
separate call in the following way:

1 Open the drop-down menu found at the end of the participant’s details on 
the phone screen.

2 Choose between End Call (to end all communication with the caller) and 
Separate Call from Conference (to remove the caller from the 
conference but keep the caller on Hold in a separate tab).
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Disbanding Conferences
To end a conference call, but keep all callers on separate ‘held’ lines in their 
own tab, open the Options menu, located benath the call display screen, and 
select Disband Conference. Each caller can be taken off Hold by clicking on 
the corresponding tab.

Suspending a Conference
Conferences can be suspended by clicking on the Hold button . 
Participants will have a hold icon next to their name on the display screen 
when a conference is suspended.
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Voicemail
The IP Softphone 3456 can be configured to regularly check your CS 1000 
voicemail box.

Voicemail Settings
Your voicemail account can be accessed by dialling the voicemail attendant’s 
extensions (101 by default), but unless configured to do so, the application 
does not automatically check for and notify you of new messages. To 
configure automatic checking and notifications:

1 From the main phone screen, open the File menu and select Account 
Settings.

2 Highlight your account and click on the Edit button.
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3 Click on the Voicemail tab.

4 Select the Voicemail check box.

5 Enter the number you would normally dial to access the voicemail 
attendant in the Number to dial for checking mail text box (by default, 
the voicemail attendant’s extension is 101, check with your system 
administrator if you are unsure).
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6 Click OK.

7 Click Apply.

8 Click Close.

The IP Softphone 3456 is now configured to check the CS 1000 server for 
voicemail messages. When a message arrives, an envelope icon  will 
appear on the interface.

Accessing Voicemail
Voicemail can be accessed from the IP Softphone 3456 in one of two ways:

• dial the voicemail attendant extension (101 by default).

• cli ck the envelope icon (the envelope icon only appears when there 
are unheard messages in your inbox).

Video Phone
The IP Softphone 3456 is equipped with a videophone feature. To make a 
video call, you and the call recipient needs a webcam-enabled softphone or 
video-enabled hardware phone (such as Nortel 1535 video IP phone).
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Making a Video Call
To make a video call:

1 Click the Video button  to open the video panel.

2 Enter the number of the person you would like to call and then click the 
Video Call button. Alternatively, right-click on a contact in the Address 
Book and select Video Call.
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Receiving a Video Call
When you receive a video call, the video panel opens automatically when you 
answer the call and you are be able to see the caller using their own video. To 
start sending your video, click Start Video.

Note: The caller and recipient can start or stop their video stream at any time 
during a call.

Video Conferencing
Note: The IP Softphone 3456 supports up to six video conference attendees. 
To take part in the video conference, the other participants must be using 
video capable phones.

To start a video conference:

1 Open the video panel by clicking on the Video button .

2 Place a call to the first participant. Your video automatically appears on 
their screen, but they have to enable their own streaming so that you can 
see them.

3 Click the Start another button  to open another tab and place the first 
call on hold. Dial the next participant. Repeat this step until all participants 
are on the call.
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4 Click the Conference All button to join all participants into one conference 
call.

Managing Conference Calls
Most conference controls, such as participant removal, suspend, and disband, 
are managed from the main phone interface during a video conference. Users 
can stop their own video output by clicking on the Stop my Video button found 
on the video panel.

Removing Participants
A participant can be removed from the conference call and placed into a 
separate call in the following way:

1 Open the drop-down menu found at the end of the participant’s details on 
the phone screen.

2 Choose between End Call (to end all communication with the caller) and 
Separate Call from Conference (to remove the caller from the 
conference but keep the caller on hold in a separate tab).
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Disbanding Conferences
To end a conference call, but keep all callers on separate ‘held’ lines in their 
own tab, open the Options menu, located beneath the call display screen, 
and select Disband Conference. Each caller can be taken off hold by clicking 
the corresponding tab.
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Suspending a Conference
Conferences can be suspended by clicking the Hold button . Participants 
have a hold icon next to their name when a conference is suspended.
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Troubleshooting
This chapter describes various troubleshooting tips.

Navigation
• Configuration changes do not work (page 40)

• Call Detail Reporting (page 40)

Configuration changes do not work
When making configuration or preference changes, you must first select the 
account to which to apply the changes. By default, the first account in the list 
is selected.

Call Detail Reporting
Call Detail Reporting (CDR) is available for all universal extension connectors 
(UEXT) and for Session Initiation Protocol (SIP) Trunk.
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